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Introduction

CTR2-Flex firmware is the descendant of a long line of microcontroller-based radio controllers from
Lynovation. If you’re interested in its background, you can read the QEX and QST articles about the CTR
series here.

Both CTR2-Flex and CTR2-Dial firmware are included starting with the release of CTR2-Flex v2.00.00
firmware. You can easily switch between the two firmwares in the Settings menu to fit your operating
needs. You should refer to the CTR2-Dial Firmware Manual for information about running CTR2-Dial

firmware.

This firmware runs on any M5Dial based CTR2 controller including CTR2-Uno, CTR2-Duo, CTR2-Quad, in
addition to the older CTR2-Flex, and CTR2-Dial hardware.

CTR2-Flex firmware creates a custom WiFi controller specifically designed for the Flex 6000 and 8000
SDR radios. It is based on the popular CTR2-Micro controller firmware. It utilizes the Flex Network API to
monitor and control the Flex radio over an IP network connection. In addition, it provides real-time CW
keying and PTT control over the network.

Because the Flex API is a two-way protocol, unlike CTR2-Dial, CTR2-Flex is aware of the radio’s operating
state (frequency, mode, band, etc). A Dashboard display provides easy access to many of the radio’s
functions.

NOTE: If this firmware is installed on the older dual-encoder CTR2-Dial hardware you must select either

# Knobs: Two or # Knobs: Swap A/B in the Settings menu, otherwise the encoder on Port B will
continually key the internal keyer.
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How to use this manual

This manual should be used as a reference manual. An expanded Help system if you will. Items in the
Table of Contents link to their write up in the manual. I've tried to group things logically and have added
hyperlinks so you can quickly jump to other sections.

As this document evolves, sections that have changed since the last update will be highlighted in yellow.
The version number of this manual will follow the latest released version number of the firmware.

Feel free to contact me if you have question about a certain feature or have ideas for future
improvements. | love to get feedback on my work. My email address is good on QRZ.com.

Legal Notice
What would a manual be without a legal notice? Here goes...

e This is a hobby endeavor. Nothing is guaranteed! Use this device at your own risk!

e | will do my best to make sure you receive functioning hardware if you buy the assembled unit
and will work with you if there is a problem with your unit on arrival.

e | cannot guarantee or warranty the hardware supplied in kits.

e | make no warranty that the firmware provided will perform up to your expectations or be
suitable for your application. A lot of compromises had to be made to fit the small display so
review this manual to be sure you’re comfortable with the user interface.

e Software bugs are a fact of life and | try to find and correct all bug reports to the best of my
ability ASAP.

o CTR2-Flex requires a license key to be fully functional. License keys can be purchased separately
if you build your own unit. They are included with any purchase of any M5Dial based CTR2

controller from Lynovation.com.

e License keys are tied to your call sign. This allows you to use the same key on as many devices as
you own. You are not allowed to include your license key on units you build to sell or give to
others. They will need to purchase their own key.
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Change Log

v2.05.00: March 4, 2026
e Updated the information in Import Settings section
e No changes to the CTR2-Flex firmware.
e Several changes were made in CTR2-Dial firmware. See the CTR2-Dial firmware manual for

those updates.

v2.04.01: February 12, 2026
e Updated Appendix A: Installing or Updating CTR2-Flex Firmware to include ESPConnect as the
primary method to flash firmware to the M5Dial on PCs and Macs (sorry, not Linux).

e Fixed the text editor page so pressing and turning knob A moves the editor cursor — previously it
was executing the function assigned to knob A’s switch.

e Removed the second page of Dial functions for the Uno’s Knob menu. Only 6 functions are
available for the knob now.

e Extensive changes were made to CTR2-Dial firmware. It it’s firmware manual for details.

v2.04.00a: January 30, 2026
e Revised this manual to focus on CTR2-Flex firmware. Hardware references have been moved to
the CTR2-Uno, CTR2-Duo, and CTR2-Quad hardware manuals. Click the links to open these
manuals.
e A new configuration repository has been added for CTR2-Dial users. to the Lynovation web site
under Download -> Configuration Files. The CTR2-Flex is pre-configured and doesn’t require
user configuration, other than setting the WiFi credentials and radio IP address, as covered here.

e CTR2-Dial firmware is covered under a separate manual. This manual can be found here.
e The following new features have been added to this version:
o Support for CTR2-Quad’s four knobs, two pushbuttons, and separate input jacks for
paddles and key/PTT
Added Ring: Fine-Tune mode to the Settings menu
Support for three WiFi profiles for users that use their controllers on more than one
WiFi network
o Added the option to export just your unit’s basic settings or its basic settings and all of
your favorite frequency lists. Export just the basic settings when sharing your unit’s
configuration with others.

Changes to previous firmware versions can be found in Appendix F

System Overview

CTR2-Uno, CTR2-Duo, and CTR2-Quad utilize the
M5Dial from M5Stack. The M5Dial is small, rugged
controller based on the ESP32-S3 processor. It

SEHE -

>

includes a 1.28” round color touchscreen display and

an integrated encoder (the gray ring). It can be
powered from a USB connection, an external 6-to-36-volt battery, or from a 3.7-volt Lithium battery.
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The current versions of CTR2 M5Dial based units use USB for power. The user can upgrade their unit to
use these other power sources if desired.

CTR2-Flex firmware is compatible with Flex 6000 and 8000 model radios. It uses WiFi to connect directly
to the radio over your IP network using the Flex APl and provides a small but flexible control surface for
your radio. Unlike controlling SmartSDR with a mouse, SmartSDR doesn’t need to be “in focus” on your
computer to use your CTR2 controller. In addition, its small size allows you to conveniently locate it
anywhere on your operating desk.

Since it connects directly to the radio it works with any Flex control app including SmartSDR for
Windows and SmartSDR for i0S/MacOS.

CTR2-Flex firmware provides the essential controls you need to operate your radio without any other
control app. This is ideal if you just want to monitor a band or operate your radio in POR mode (i.e. Plain
Old Radio) without booting your computer or iPad to use SmartSDR.

CTR2-Flex firmware includes a built-in keyer that produces a sidetone on all M5Dial based CTR2 controls
(with the exception of the older CTR2-Dial hardware). It can also send both key and PTT inputs to the
radio over the IP network. Using Straight Key keyer mode allows you to connect an external keyer, PTT
switch, or app such as N1IMM to the controller’s CW paddle jack to key the radio. In addition, the virtual
PTT switch can be configured for momentary or latched PTT.

CTR2-Flex firmware has two user interfaces and you can use the one that works best for you.

Multiple Controllers / Two Firmwares

As mentioned previously, three versions of hardware and two versions of firmware are available. Which
hardware device you choose depends on your use case. Both versions of firmware are included in the
CTR2-Flex firmware binary starting with v2.00.00. You can choose the firmware you want to run from
the Settings menu. CTR2-Flex and CTR2-Dial firmware runs on any M5Dial based CTR2 hardware.

CTR2-Flex firmware is great for controlling your Flex 6000/8000 series radio locally running any version
of SmartSDR (or even without the SmartSDR user interface). However, since it doesn’t support
SmartlLink, it presents challenges for remote operation.

CTR2-Dial firmware on the other hand, uses MIDI commands over Bluetooth or USB to control a 3™
party app such as SmartSDR for i0S/MacOS, SDR-Control, FT-Control, TS-Control, K4-Control, Thetis,
SDR-Console, and many other apps that support MIDI control of their functions

Switching Firmwares

To switch firmwares, open the Settings menu and navigate to the last page (page 11 on CTR2-Flex and
page 9 on CTR2-Dial) and select Run CTR2-Dial or Run CTR2-Flex, depending on which firmware is
running.
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The diagrams below should give you an idea of how each firmware interfaces to your radio and your

computer/iOS device.

When using CTR2-Flex
firmware as shown here,
the controller connects
to, and directly controls
the radio through the IP
network using WiFi and
the Flex Network API.

When using CTR2-Dial
firmware, the controller
connects to, and
controls the 3™ party
app that is controlling
the radio.

CTR2-Flex fiware running =77 e

on CTR2-Uno hardware Flex 6000/8000 radio SmartSDR running on
connected to both Windows, iOS, or MacOS
CTR2-Flex and SmartSDR a
with Flex Network API PC connected to router

with WiFi or CATS

Bluetooth*

CATS to radio

s,

e " SmartSDR running on * Flex 6000/8000 radio
e R e SR Mac or iOS device connected to SmartSDR

CTR2-Dial firmware running
on CTR2-Uno hardware

** CATS or WiFi from
Controlling SmartSDR using MIDI SmartSDR to radio

* Bluetooth or USB MIDI
to SmartSDR

There are a few of trade-offs when running CTR2-Flex firmware on older CTR2-Dial hardware:

o CTR2-Dial hardware doesn’t have encoder switches so you can’t press and turn Knob A to
change the frequency step or assign Knob switches to Button functions.

o CTR2-Dial dual-encoder hardware doesn’t support the CW paddle input jack while the older
CTR2-Flex hardware (rebranded to Uno and Duo) and the newer CTR2-Uno, CTR2-Duo, and
CTR2-Quad hardware does

e The M5Dial’s speaker is used for sidetone on CTR2-Dial hardware — it’s pretty quiet

An upgrade kit is available for those wishing to upgrade their older CTR2-Dial or CTR2-Flex hardware to

a CTR2-Quad.
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CTR2-Flex Features

CTR2-Flex runs on the M5Dial from M5Stack. The M5Dial features an ESP32-S3 processor, a 1.28” color
touchscreen, and a built-in selector ring and hardware pushbutton. The firmware includes the following

features:

e  WiFi connectivity — connects directly to the radio
e Three WiFi profiles can be set up for users that operate from multiple networks.
e Multiple CTR2 units running the CTR2-Flex firmware can be connected to the same radio, to the
same slice or different to a different slice
e Works with any version of SmartSDR (Windows, iOS, or MacOS)
e CTR2-MIDI or CTR2-Dial MIDI controllers can be used at the same time in SmartSDR for
i0S/MacOS apps while a CTR2 unit running CTR2-Flex firmware is connected
e Works in standalone mode without SmartSDR
e Two user interface modes
e Menu pages provide easy to use controls if you just want to control one or two items
e Dashboard pages provide a small control surface for your radio with easy access to all

functions
e 60 virtual button controls for modes/bands/filters or page selection

e 30 virtual Dial (wheel/slider) controls for tuning frequency, volume, RIT, XIT, etc.

e Assign the gray Ring encoder on the M5Dial display to any of the available Dial controls

e Up to four optional physical encoders (referred to as Knobs)

e Map 12 of the Dial controls to the Knob on the CTR2-Uno unit
e Map 6 of the Dial controls to each Knob on the CTR2-Duo unit
e On the CTR2-Quad unit:
i. Knobs can be programmed to two functions (turn and push-and-turn)
ii. Unassigned knobs control the selected Dial control and the selected control in
the dashboard
e Knob push switches can be mapped to two virtual button functions using short and long-
press

e Two pushbuttons are provided on the CTR2-Quad — each of these can be programmed to any
two button functions (using short and long-press) or be dedicated to control PTT.

e The gray ring on the M5Dial can be configured as a fine-tuning control (to make fine
adjustments to the selected Dial function), or it can be assigned to always control the selected
Dial function, or it can be assigned to always control any of the Dial functions in any page.

e VFO Lock control

e 3.5mm (1/8”) stereo input jack allows you to use your paddles to control the keyer, straight key,
or PTT over the network connection

e Separate jacks are provided on CTR2-Quad for paddles and key/PTT

e Nine CW macros

e Swipe tuning for parameter adjustments on the Dashboard pages

e Panadapter control

e Control any slice, A through H, depending on radio’s capacity

e Adjustable filter controls — adjust low-cut, high-cut, and offset independently
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e Speaker with volume control for sidetone

e Avirtual PTT switch or hardware PTT switch. On CTR2-Quad you can select either pushbutton as
a dedicated PTT switch.
NOTE: Switch #1 on CTR2-Quad is hardwired to the RING input on the Key/PTT input jack.

e Keypad for direct frequency entry (press Frq on the dashboard Home page)

e Favorite frequency lists for each band

e Speed sensitive controls

e Adjustable virtual Dial sensitivity

e Seven color themes and backlight control

e Sleep and power down timers to save battery power
e Manual power down

e  Multiple Power options

e Backup CTR2-Flex’s settings using the Import and Export Settings option
e Easily switch between CTR2-Flex and CTR2-Dial firmware

Initial Startup

There are a few tasks you must perform before the CTR2-Flex firmware will be ready to control your
radio.

Enter your Call and Registration Key

You must enter your call and registration key for your firmware using a terminal or the on-screen editor
if you purchased a CTR2-Quad upgrade kit and purchased the M5Dial separately. Registration keys are
provided for free and installed when you purchase an assembled unit from me or Neil.

NOTE: Registration keys are issued based on your call sign. Once registered you can use your key on any
M5Dial based Lynovation product (CTR2-Dial and CTR2-Flex). Contact me if you decide to sell your
controller to another ham and | will create a key for their call. My email is in QRZ.com.

The firmware will run in Demo mode until registered. In this mode, the unit will automatically power
down after 15 minutes. You can edit the settings and labels on the unit but you can’t save or export
them.

To enter your registration key, connect your unit to a terminal program such as Tera Term or Putty (see
Appendix B or C, or to the terminal in your Mac, Appendix D). Once connected, press any key to start the
terminal server on the unit. Next, press the Del or Backspace key on the keyboard. Enter the call sign

you registered and the registration key you received from me. The registration key is 8 hexadecimal
digits (0 to 9 and A to F). Once registered, your call sign will appear on the splash screen at boot up, the
program won’t shut down after 15 minutes, and you’ll be able to save changes in the maps and import
or export backup files. You call will can also be automatically inserted into CW macros using the A
prosign.

You can also use the on-screen editor to enter your registration credentials. Just select Enter Call & Key
on the last Settings page. Turn the knob to change the letter and touch the screen (or press and turn the
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knob) to advance to the next letter position. Press the OK button to accept. The input starts with your
call and advances to your registration key once the call has been entered.

Factory assembled units have the unit’s Bluetooth name (CTR2_xxxx), your call, and your registration
key written on the unit’s bottom label. They are covered with a piece of transparent tape so they don’t
rub off. This way you’ll have them if you reset your unit back to factory settings.

The dumb terminal or on-screen editor can also be used to edit the CW macros, your router’s SSID and
password, and your radio’s IP address and IP port#.

Select the Number of Encoders

Once you have successfully registered CTR2-Flex firmware the Settings menu will open on page 4 so you
can select the number of knobs (encoders) on your unit. Your options are None, One, Two, and Swap
A/B. The swap option is used for CTR2-Duo 3D printed enclosure units. You can also reverse the
direction of each encoder if needed on Uno and Duo units.

CTR2-Quad units automatically detect the four knobs. The Knob menu page on these units includes
controls to set the PTT function of either pushbutton. This selection overrides any button functions you
may have set for these buttons.

Connecting to your radio

CTR2-Flex connects directly to your radio on your network using WiFi. Network credentials (router SSID
and password) can be entered from a terminal or directly by selecting SSID: and PW: on page 6 of the
Settings menu.

Text input is tedious in the text editor. Turn Knob A to select a character then press and turn Knob A to

advance to the next character. To minimize frustration, use the terminal interface to set these

parameters. You will also need to set Flex Adrs: on page 7 of the Settings menu. This can be found on
the Settings -> Radio Setup -> Network tab in SmartSDR for Windows or on the Available Radios popup
window in SmartSDR for i0S/MacOS. The default IP port for the Flex radio is 4992. You can change this if
it has been changed on your radio with the Flex Port: option.

If you would like CTR2-Flex to automatically connect to your radio when it boots, turn AutoConn: ON.
You can temporarily disable auto-connect by holding the M5 button on the M5Dial down during boot.

Once your WiFi credentials and the radio’s IP address have been entered, select Connect WiFi on page 6
of the Settings menu to connect CTR2-Flex to your WiFi system. Once connected, CTR2-Flex can be used
as a control surface for SmartSDR or it can operate your radio as a standalone controller.

The firmware connects to Slice A by default. Once connected you can change the Slice by touching the
Slice caption in the Dashboard display. The firmware will then connect to the new slice setting each time
you connect until you change the Slice setting again.

NOTE: Always connect CTR2-Flex to your radio after starting SmartSDR so it connects to the radio as a

non-GUI client that is linked to SmartSDR. If you connect it before starting SmartSDR v3.xx with
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multiFlex enabled, it will create a second GUI client and will work separately from SmartSDR. SmartSDR
2.xx will not be able to connect to your radio if CTR2-Flex is already connected.

Multiple Clients

The server in your Flex radio supports multiple clients. This means that you can have several devices
connected to, and controlling it, all at the same time. For instance, you can have SmartSDR for iOS
connected as a GUI client, one or more CTR2 units running CTR2-Dial firmware connected to your iPad
controlling the SmartSDR app, and one or more CTR2 units running CTR2-Flex firmware connected to
the radio as non-GUI clients. CTR2-Flex units can be connected to the same slice or to different slices.
Any change on any of the connected devices will be sent to all the other clients subscribed to that slice.

TX Enable

Flex radio support multiple slices, but only one slice can be designated as the transmit slice. On
SmartSDR this is done by clicking on the TX button on the slice flag.

- X .
21 13 100 . 21.196.000

S -111dBm N -119 dBm*¥

1 3. 5 1 3 5
| =) | posp | use | xR | DAX | | ) | osp | cw | xmriT | DAX |

Channel: [None vl Channel: [None v

CTR2-Flex allows you to toggle the transmit state of the slice using one of these methods.

e Touch the bottom-left TX button on the Dashboard’s TX page.

e Touch the Tx Enbl button on page 4 of the Buttons menu

e Assign the Tx Enbl button to one of the knob switch functions (or to one of the pushbuttons on a
CTR2-Quad).

When transmit is enabled on the slice CTR2-Flex is controlling, the caption on m

all pages will be displayed in red font. (I know, it looks orange here... it’s red) ANTI 1om 27k

When using multiple CTR2-Flex controllers this allows you to easily identify 28.074.000

which controller is controlling the transmitter on your radio. RX Uss DsP
X XRIT Misc
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Using an External Keyer and/or Hardware PTT Switch

Many users may want to use an external keyer and/or an external PTT switch with their CTR2 unit. If
your external keyer has a built-in sidetone you can use a small Phillips screwdriver to turn the sidetone
volume on the CTR2 unit down.

On CTR2-Quad, simply plug you straight-key, keyer, or PTT switch into the Key/PTT 3.5mm jack on the
back of the unit. Wire the Key input to TIP and SHIELD and your PTT switch to RING and SHIELD of the

plug.

NOTE: The RING on CTR2-Quad’s Key/PTT jack is hardwired to Switch 1 on the front panel. This means,
that in order to use an external PTT switch with CTR2-Quad, you must assign Switch 1 to PTT (see SW1
on page 4 in the Settings menu). Otherwise, your external switch will control the functions assigned to
Switch 1.

To use an external key/keyer, or PTT switch on CTR2-Uno, CTR2-Duo, and the older Flex and Dial
hardware, do the following:

e Wire the external keyer (or straight key) to the Tip and Shield of a 3.5mm (1/8”) stereo plug
e Wire the external PTT switch (foot switch, hand switch, etc.) to the Ring and Shield of the same
stereo plug
e In the Settings menu:
o On page 2 select Momentary or Latch for PTT: - this determines the PTT action
o On page 5 select Passthru for the (paddle) Type: - this passes the paddle jack’s Tip input
to the CW Key function and the Ring input to the PTT function

Now that you have your hardware wired, configure the firmware as follows:

e Enable TX on the slice you're controlling — this can be done in the Button menu or in the TX
page in the dashboard

e To enable CW keying, select CW mode and enable Breakin in the dashboard’s Misc menu

e To enable PTT, select a voice mode in the dashboard’s Mode menu
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User Interfaces

CTR2-Flex firmware supports two user interface models. The Basic User Interface (left screenshot) uses

simple menus to select controls and buttons, similar to CTR2-Dial firmware, and will be described in the

next section. Use this interface when you just want to use your CTR2 unit to control one or two

parameters. The second user interface (right screenshot) is a fully functional dashboard that allows you

to easily select and modify parameters. Go to the Dashboard section for a full description of this user

interface.

NOTE: When using either Ul, Knob A is used to change the selected parameter on CTR2-Uno, CTR2-Duo,
and on the older CTR2-Flex and CTR2-Dial hardware. On CTR2-Quad, any knob set to <DIAL> will control
the selected parameter.

A0

ANT1 10m 27k

Dial  Buttons

28.074.000

Knob
DashBrd

RX UsB DSP
TX XARIT Misc

Basic Ul Dashboard Ul

Basic User Interface

CTR2-Flex’s Home page allows you to open the control pages in the basic user interface. This interface is
the same interface used on CTR2-Dial firmware, with the addition of the DashBrd button.

e Dial opens the Dial control. This is a virtual dial where you can select from 30 different

parameters to control. Once selected, just swipe your finger around the perimeter of the display

to change the parameter. To change the selected parameter, turn the gray ring on the M5Dial or

touch the control # above the center label to open the Dial menu.

(0]

If the Ring option in the Settings menu is set for Ring: Fine-Tune, touching the outside
ring on the display enables Ring fine-tuning mode. In this mode, turning the ring will
adjust the selected control by one count per ring click. Fine-turning will turn off after 3
seconds.

If the Ring option in the Settings menu is set for Ring: Sync2Dial, disables ring navigation
(switching pages or Dial controls with the ring) and adjusts the selected control in the
Dial page as you turn the ring on any page. To navigate between pages, touch the page
#s at the bottom of the display, or touch the control # in the Dial control to open the
Dial menu

If the Ring option in the Settings menu is set to a Dial control (for example Ring:
Volume), ring navigation is disabled and turning the ring on any page adjusts the Dial
control selected in the Ring option. To navigate pages, touch the page #s at the bottom
of the display, or touch the control # in the Dial control to open the Dial menu.
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e Button opens the Buttons menu where you can select from 60 functions on ten menu pages.

Turn the gray ring on the M5Dial to change menu pages or touch the page #s at the bottom

button to switch pages.

o You can assign a button function to any of the knob pushbuttons (or pushbuttons on
CTR2-Quad) on your unit. To do this, find the button function you want to program
in the Buttons menu. Press and hold the pushbutton you want to assign, then touch
the button control to assign to the switch. The knob (or button # on CTR2-Quad) will
appear in the button’s label. The first touch assigns it to the switch’s short-press.
Touch the button again, (while still holding the switch down) to set the long-press
function. When set as the long-press function, the knob (or switch #) will be

“Unst?

displayed with a “~”.

e Knob opens the Knob menu where you can assign Dial controls to the knobs. This menu allows

you to quickly change the Dial control assigned to a knob.

(0]

On CTR2-Uno units (and older single-knob CTR2-Dial and CTR2-Flex units) you can select
from 12 different Dial controls.

On CTR2-Duo units (and older dual-knob CTR2-Dial and CTR2-Flex units) you can select
from 6 different Dial controls for each knob.

On CTR2-Quad units you can assign a turn and push-and-turn Dial function to each
knob. Unassigned knobs use the selected Dial control, or adjust the selected Dashboard
control.

o DashBrd opens the Dashboard user interface that is described in this section.

e PTT opens the virtual PTT page where you can control PTT on your radio by simply touching the

display. There are three modes on this page. They can be controlled by touching the bottom

button in this display or in the PTT option in the Settings menu.

(0]

Off disables PTT control from this page, and from the external PTT input. It also disables
PTT control on the CTR2-Quad if PTT is assigned to one of the pushbutton switches.
Momentary enables momentary PTT control. PTT is key up as long as you press the PTT
switch and drops off when you release the switch.

Latched enabled latched PTT. Touch and release the screen (or PTT switch) to key PTT. It
will stay keyed until you touch and release PTT again.

e Settings opens the Settings menu where you can change the configuration of many of CTR2-

Flex’s parameters.
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Dial Control

The virtual Dial control supports 30 controls. Swipe your finger around the
outer ring to adjust the control.

If a knob is set to <DIAL> in the Knob setting menu, turning the knob on a EREETY
single or dual-knob unit (or any unassigned knob on CTR2-Quad) will adjust W
the value of the currently select control in the Dial control.

If the gray ring on the M5Dial is in navigation or fine-tune mode, turn the ring

to switch dial controls. Otherwise, touch the dial # (1 in this example) to open the Dial menu where you
can select a dial function from 5 pages of menus.

If the ring is in fine-tune mode (Settings -> Ring: Fine-Tune), touching the outside ring (the blue ring in
this photo) enables fine-tune mode and <RING> will be displayed in the page caption. Turning the ring
while in this mode adjusts the current control’s value. Fine-tune mode times out after 3 seconds of
inactivity.

NOTE: When the Dial control is in VFO mode, as shown above, the push-and-turn function of Knob A is
used to change the frequency step.

Control options, if any, will be displayed at the bottom. In this VFO example, v 100 ~ controls the
frequency tuning step. Touch to the left or right of 100 to change the tuning step.

The VFO display also has a Zero button. Touch this button to zero the digits below the tuning digit.

Other controls such as Volume, NB, NR, RIT, and others have virtual On/Off options. Touch the control
at the bottom of the display twice to toggle the option.

Dial Graphics
The Dial’s background depends on the selected control.

The lead photo in the Dial Control section shows a tuning control. Tuning controls are continuously
variable and used for VFO tuning. The tuning ring is the background color of the selected theme. The
label in the middle (in this case VFO) indicates the control function. Unlike CTR2-Dial firmware, you
cannot edit the control labels, these are fixed in firmware.

There are two other control displays. These controls are similar to potentiometers and have a minimum
and maximum range.
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For most controls like volume, squelch, etc., the outer touch ring on the Dial
control represents a gauge with the level indicated by the filled portion. Like a D;\L
potentiometer, the gauge starts at 0% on the lower left and progresses

around the display to 100% on the lower right. The Volume control on the 2

right is set to 55%. Volume
55%

Controls with positive and negative offsets, like RIT, XIT, and Balance controls v
use a slightly different display. The Dial graphic for this control displays the +/- DIAL
offset referenced to the top of the dial. For negative offsets it grows to the 14
left and for positive offsets it grows to the right from center. The amount of RIT>

offset (in this case RIT frequency) is shown under the label. When the control 2200

is offset, touch the label to reset it to 0 offset. If a control has an
RiITisON _

enable/disable or zero option it will be displayed at the bottom of the dial.
Touch this button to operate the control.

Shortcut: Touch to the /eft of the DIAL caption at the top to open the Knob menu. Touch to the right of
the DIAL caption to open the Buttons menu. Similar options are provided on the Knob and Buttons
menus.

VFO Control

When the VFO control is selected the frequency and frequency step will be
displayed in the center of the control. Touch any digit in the frequency to
select that digit as the tuning step. The step digit will turn red. Touch it again

to select the half-step. 18.130.100

For example, touching the 100’s digit (1) in the example at the left switched W
the frequency step from 100 Hz to 500 Hz. Half-steps are indicated by

highlighting the digit to the left in magenta.

You can also press and hold, then turn Knob A while in this control to change the frequency step. You

can also touch the left or right side of the bottom ” xxx v button twice to change it.

Pressing the Zero label in this control will zero all of the digits below the frequency step digit.

Hint: You can quickly change to the Button or Knob menus from the Dial control by swiping across the
center of the display either left or right. Swipe from the left to open the Knob menu or from the right to
open the Buttons menu.
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VFO Lock

To lock VFO tuning to prevent inadvertent changes simply long-press the
frequency on the VFO dial control or on the Dashboard Home page. When the
VFO is locked, the frequency will be “grayed out” as shown here. Adjusting
the tuning, or turning a knob assigned to the VFO, will post a message with
instructions on how to reset the lock.

To unlock the VFO, long-press the frequency digits.

Ring Control Options

The encoder used in the gray ring control on the M5Dial display is a detent (bumpy) encoder with 12
“clicks” per rotation. Because it isn’t very sensitive, and somewhat difficult to turn, it has only been used
for selecting dial controls and menu pages (i.e. navigation).

By user request, beginning with v2.02 I've added the ability to choose from several ring control options
with the Settings menu’s Ring option on page 8.

e Navigation mode — (default) — use the ring to select dial controls and menu pages.

e Fine-Tune mode — while in the Dial control page, touching the outside ring on the display
enabled fine-tune mode. <RING> will be displayed in red on the page caption and turning the
gray ring will increment or decrement the current control’s value by one count per click. Fine-
tune mode times out after 3 seconds of inactivity. When fine-tune mode is not active, the ring
operates in navigation mode.

e Sync2Dial mode — the ring adjusts the dial control selected in the Dial menu or on the Dial
control- this works in any page, similar to how the knobs work.

e Selected Dial Control — the ring adjusts a dial control that you select from the Ring Ctl menu.
This also works from any page.

NOTE: When Sync2Dial or Selected Dial Control modes are enabled, you must use the on-screen
navigation controls to move between menu pages. While in the Dial control you must touch the control
# (above the center label) to open the Dial menu in order to select a different dial control

The following screenshots should help explain the process of selecting a ring control option on page 10
of the Settings menu.

Navigation mode

The screenshot at the right shows that the ring is in the
default Navigation mode.

SETTINGS

Ring: Navigation

In this mode, turning the ring will change menu pages or the
selected control on the Dial control page.

The antenna icon at the top of the page is solid.

Double-touch the Ring: Navigation button in the Settings menu to switch to Fine-tune mode.
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Fine-Tune mode

In Fine-Tune mode, the antenna icon has a single line through £

Ring: Fine-Tune

In this mode, the gray ring on the display can be used as a
fine-tuning control for the selected dial control. To enable
fine-tuning, touch the outside ring on the Dial control page.
<RING> will be displayed in the page’s caption. Turning the
ring will now increment or decrement the current dial
control’s value by one count. Fine-tune mode will time out
after 3 seconds on inactivity.

Double-touch the Ring: Fine-Tune button in the Settings
menu to switch to Sync2Dial mode.

Sync2Dial mode

In Sync2Dial mode the M5Dial’s ring controls the currently :
selected Dial control from any page, similar to how the Knob m

controls work. Ring: Sync2Dial

In this mode, two lines are displayed in the antenna icon at
the top of each page.

NOTE: While Sync2Knob mode is active, you must use the onscreen navigation controls to
switch menu pages. On the Dial control, you must touch the control # above the center label to
open the Dial menu to select another dial control.

Touch the Ring: Sync2Dial button to open the Ring Control menu.
Ring Control Menu

The Ring Ctl menu appears when you double-touch the Ring
option in the Settings menu while in Sync2Dial mode. It is
similar to the Dial menu and is used to assign one of the dial
controls to the Ring control. There are 5 pages of menus. You »
must use the Next button on the bottom to step to the next Volume Moni
page because the ring mode is still in Sync2Dial. Touch a
control label to assign that control to the Ring control. In this Squelch Balance

example, the AGC-T control is selected. W

Pressing Esc will exit this menu and reset the ring mode to
Navigation mode.
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Selected Dial Control Mode

Once you select a control in the Ring Control menu you will
return to the Settings menu and the Ring: option will show
the selected control (AGC-T in this example).

Note that there are now three lines in the antenna icon at the
top of the page in this mode.

Ring: AGC-T

NOTE: While Selected Control ring mode is active, you must use the onscreen navigation

controls to switch menu pages. On the Dial control, you must touch the control # above the
center label to open the Dial menu to select another dial control.

To return to ring Navigation mode, touch the Ring: button in the Settings menu again.

Dial Menu

Touching the dial # on a Dial control will open the Dial menu. The current dial
setting will be highlighted (VFO in this example). Touch a button to select that
function and return to the Dial control page. Touch the selected function to

return to the Dial control without changing the selection.

If the gray ring on the M5Dial is in Navigation or Fine-Tune mode, turn the
ring to switch menu pages. Otherwise, touch to the left or right on the footer

button that is showing the menu page you are on (<1/5>).
The caption button (DIAL MNU) is a two-function button.

e Touch the /eft side to switch to the Knob menu.
e Touch the right side to switch to the Buttons menu.

Dial functions are listed in the table below.

AGC-T

Volume Moni

Squelch Balance

VFO Slice freq control NB-Lv Noise Blanker Lvl HPh-Gn | Headphone Gain
Volume | Slice volume NR-Lv Noise Reduction Lvl Speed Keyer Speed
Squelch | Slice squelch ANF/APF | Auto Notch/Peaking | Pitch Sidetone freq
AGC-T AGC-Threshold RIT Rx Increment Tuning | Delay CW Dropout Delay
Moni Monitor level XIT Tx Increment Tuning | Zoom Panadapter Zoom
Balance | Left/Right balance PwrOut | Tx Power Out PanMax | Panadptr Max Level
Hi-Cut Filter high cut freq TunOut | Tune Power Out PanMin | Panadptr Min Level
Lo-Cut Filter low cut freq VOX VOX Level PanAvg | Panadptr Average
Offset Filter high/low offset | Mic-Gn Mic Gain PanGn Panadptr Gain
WNB-Lv | Wide Noise Blanker LnO-Gn | LineOut (Spkr) Gain PanBlk Panadptr Black Lvl

Hint: Quickly change to the Knob or Buttons menus by swiping across the center of the display either

left or right. Swipe from the left to open the Knob menu or from the right to open the Buttons menu.
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Knob Menu

The Knob menu allows you to assign Dial controls to the knob(s) on the unit.

The caption at the top of the page is a dual-function button. Touch the left side to navigate to the Dial
control page, and touch the right side to navigate to the Buttons page. To prevent unintended
operation, the caption button requires two touches.

e Touch the /eft side to switch to the DIAL control.
e Touch the right side to switch to the Buttons menu.

If the gray ring on the M5Dial is in navigation mode, turn the ring to switch pages. Otherwise, touch the
footer button.

The style and functions of the Knob menu depend on the controller you are using.

CTR2-Uno and CTR2-Duo Controllers

On these units, each knob can be assigned to one of 6 functions. Duo units have a menu page
for each knob.

The first option always displays <DIAL>. When this option is selected, turning the Knob on any
page will change the control selected in the Dial control page.

Selecting one of the other five functions on this page assigns that function to the Knob and it
will be controlled independently from the Dial control. On Duo units, touch the bottom button
to navigate to the next menu page.

CTR2-Quad Controller
The Knob menu on the CTR2-Quad is different than the menu for the

Uno and Duo controllers, but editing the selected controls is the same m

as with the other units. Set NR Lv
Knob Turn
CTR2-Quad supports dual-function knobs. Each knob has a turn and a Func RIT Fq

push-an-turn function. <DIAL> VFO

The menu you are in is displayed in a label block on the left side of the

menu. In this photo, we’re in the Set Knob Turn Function menu.
The functions assigned to each knob are show on the buttons.

The Knob menu is laid out the way the knobs are positioned on the Quad. Knob A is the bottom-
left button (and shown selected in this photo), knob B is the upper-right button, knob C is the
right-middle, and knob D is the bottom-right button.
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Touching the black label toggles the menu to the Set Knob P&T Func
(Push-and-Turn) menu. This menu allows you to assign the Dial control
that is used when you push the knob down and turn it (while holding
it down).

NOTE: Any knob on CTR2-Quad can be assigned to the <DIAL>
function. When this function is selected, the knob will control the
selected Dial control. Knobs assigned to <DIAL> will also control
parameters selected in the Dashboard.

Editing the Knob Menu
You can easily change the Dial control assignments in the Knob
menus. Just touch a button to select it, then touch it again to edit it. KNOB A T

The selected function and the bottom button will turn red. Turn any VFO * AGC-T

knob to scroll through the functions available in the Dial control
menu. VFO Zoom

Volume Speed
Touch the < Select > button on the bottom or let the select timer

timeout (3 seconds) to save the new setting. < Select >

NOTE: On CTR2-Uno and CTR2-Duo (and older Flex and Dial hardware) the first function
(<DIAL>) cannot be changed in this menu.

Using the Knob

The Knob control display overwrites the current page anytime a knob is
turned. The display is identical to the Dial control page but the colors are
inverted. The current page re-appears 750 milliseconds after you stop turning
the knob.
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Buttons Menu

Open the BTN MNU to select from 60 button functions. Touching a button

immediately sends that control to the radio (if the controller is online).
Mode A Band?

There are 10 pages of buttons with six buttons on each page. The last six Modev  Bandv
buttons open pages on the controller. If the gray ring on the M5Dial is in

Mute BW

navigation or fine-tune mode, turn the ring to select a page, otherwise, touch

the left or right side of the bottom label to decrement or increment the page
#.

To prevent unintended operation, the caption and footer buttons are dual-touch buttons. The first
touch selects the button and the second touch executes the selected function. Press the M5 button on
the orange ring to return to the Home page.

The caption button (BTN MNU) has the following functions:

e Touch the /eft side to switch to the Knob menu.
o Touch the right side to switch to the Dial menu.

Assigning a Knob Switch to a Button Function

Knob switches (and pushbuttons on a CTR2-Quad) can be set to two actions: a short-press (less
than 1 second) and a long-press (greater than 1 second).

Switch Short-Press Action
To assign a short-press button action to a knob’s push switch (or pushbutton on a CTR2-Quad),
do the following:
e Open the Buttons menu and navigate to the page with the function you want to assign
e Press and Hold the Knob (or pushbutton on the Quad) switch you want to use
o Touch and release the function button you want the switch to execute

Once you have assigned a function to a Knob (or pushbutton on the Quad), the knob’s letter (or
switch #) will appear in that button’s label. That function will be sent to the radio anytime you
press that Knob (or pushbutton).

Switch Long-Press Action

To assign a long-press button action to a knob’s push switch (or pushbutton on a Quad), follow
the steps above for setting the short-press action then while still holding the knob (or switch)
down, touch the desired function a second time. Buttons set to long-press actions will have a ~
appended to the knob (or switch #) displayed on the button.

The photo above shows the Buttons menu on a CTR2-Quad. Knob A’s short-press action is set to
the Mute function and its long-press action is set to the BW function. Knob D’s short-press
function is set to Band ” and its long-press action is set to Band v.
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To clear a function, hold the Knob switch down and touch the selected function again.

NOTE: You must clear both switch actions from the button before you can assign it to another
knob or switch#.

NOTE: Changing the PTT assignment on CTR2-Quad’s pushbutton #1 or #2 (on page 4 of the
Settings menu) automatically cancels any switch action assigned to those switches.

NOTE: Buttons are preset in the factory default. Feel free to edit them to fit your operating
requirements.

PTT Page
The PTT page offers a virtual PTT button. There are three options to choose ra
from on this page. Touch the bottom button to step from PTT Off, PTT
Momentary, and PTT Latch modes.

PTT

Touch to

When PTT is Off, touching the screen, or operating an external PTT switch has
no effect.

When PTT is set to Momentary, touching the screen or operating an external
PTT switch keys the radio’s PTT over the network. Lifting your touch or releasing the external PTT switch
unkeys the radio.

When PTT is set to Latch, touching and releasing the touch keys the radio over the network. It will
remain keyed until you touch and release the screen again or the three-minute timer expires.

NOTE: An external PTT switch will control PTT in any page or menu.
Using a Hardware PTT Switch

To configure an external hardware PTT switch, see Using an External Keyer and/or Hardware PTT Switch.

Settings Menu

To enter the SETTINGS menu, press the Settings button at the bottom of the m

Home page.

PTT: OFF
The settings menu is divided into 11 pages with three buttons on each page. Theme: Blue
You must press a settings button twice to change its setting.

Backlight: Med1

Press the M5 button or touch the SETTINGS caption to return to the Home
page.

If the Ring on the M5Dial is in navigation or fine-tune mode, turn the ring to select a settings page,

otherwise, touch the left or right side of the bottom label to decrement or increment the page #.

The table below summarizes each setting.
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Page

Btn

Function

Description

Beep Mode

Changes the volume of CTR2-Flex’s button beeps. Range: Off,
Low, Medium, and High. Sidetone volume is set through a small
hole in the enclosure using a 1/8” (3.2mm) Phillips screwdriver.

Speed Tune

When enabled, touch and hold the outer ring on the Flex for > 1
second to enter speed tuning mode. Valid for VFO control only.

Dial Sens

Changes the sensitivity of the virtual Dial. Range: Low, Medium,
High. Default is Medium.

PTT

Changes the PTT mode from Off -> Momentary -> Latch. This can
also be changed on the PTT page by touching the bottom button.
This option also controls keying PTT with a hardware PTT switch.

Theme

Select the color theme for the selected Map. Options include
Dark, Light, Blue, Orange, Green, Red, and Violet.

Backlight

Adjusts the backlight. Range: Low, Medium1, Medium2, and
High. Lower settings reduce current draw on the unit.

Sleep

Sets a timer that turns off the display backlight after no activity
for the set number of minutes to reduce current draw. Sleep
mode does not close USB or Bluetooth connections. Range:
Never, 1, 5, 10, 30, and 60 minutes.

Pwr Off

Sets a timer to turn off the unit after no activity for the set
number of minutes. Pwr Off mode reduces current draw to 14
microamps and closes USB and Bluetooth connections. Range:
Never, 10, 30, 60, 120, and 180 minutes.

Power Down

Immediately closes the WiFi connection and puts the unit to
sleep, reducing current draw to 14 microamps. Touch the display
to wake up the unit.
NOTE: If you are powering your CTR2 controller with a
3.7-volt battery you will need to press and hold the M5
button on the orange ring for > 10 seconds to wake the
controller up from sleep mode.

# Knobs

Selects the number of external knobs your unit is equipped with.
(One and two knob configurations cannot be detected in the
firmware.)

For CTR2-Uno, CTR2-Duo, (and older CTR2-Flex and CTR2-Dial
hardware) you have the following options:

None, One, Two, or Swap A/B (for two knob units)

e When this firmware is running on CTR2-Dial hardware
the paddle jack is only available in the None and One
options.

CTR2-Quad hardware is automatically detected and this setting
is fixed to # Knobs: Four

Knob/Knob A
Or
SW1 Setup

On CTR2-Uno, CTR2-Duo, (and older CTR2-Flex and CTR2-Dial
hardware) this option selects either Normal or Reverse direction
for Knob A. The default is Normal.

On CTR2-Quad this option toggles the PTT setting of pushbutton
#1. When PTT is enabled, you can use this switch instead of the
virtual PTT page or an external PTT switch to key your radio.
NOTE: Toggling this setting resets any button switch actions that
were assigned in the Buttons menu.
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Knob B
Or
SW2 Setup

On CTR2-Duo, (and older CTR2-Flex and CTR2-Dial dual-knob
hardware) this option selects either Normal or Reverse direction
for Knob B. The default is Normal. This option is not available on
single knob units.

On CTR2-Quad this option toggles the PTT setting of pushbutton
#2. When PTT is enabled, you can use this switch instead of the
virtual PTT page or an external PTT switch to key your radio.
NOTE: Toggling this setting resets any button switch actions that
were assigned in the Buttons menu.

(Keyer) Type

Selects the internal keyer type. Options are Off, Straight,
PassThru, lambic A, lambic B, Ultimatic, and Bug — does not
change radio keyer. Use Passthru for external keyers or PTT
switches.

NOTE: CTR2-Quad units have a separate Key/PTT input jack so
there is no need to set the keyer to Passthru on these units.

Pitch

Selects the sidetone frequency for the sidetone oscillator in
CTR2 units with sidetone capabilities. This option has no effect
on older CTR2-Dial hardware. Frequency range is from 500 Hz to
1000 Hz in 50 Hz steps.

To turn off the sidetone, turn the volume control fully CCW.
NOTE: This setting also affects the radio’s audio bandpass filter
in CW mode.

Paddles

Select Normal or Reverse paddle wiring

Fav Mode

Switches the Favorite Frequency list between all bands and the
selected band

Xvtr Mode

Indicates whether transverter mode is On or Off. Transverter
mode is automatically enabled when XVTA or XVTB are selected
in the dashboard’s Ant menu. When transverter mode is enabled
2m, 1.25m, 70cm, 33cm, and 23cm bands are added to the Band
menu and the frequency display is slightly compressed to display
the additional digits.

WiFi Profile

This option allows you select one of three WiFi configurations.
This is useful when you have more than one WiFi network that
you use your CTR2 controller on.

Connect/
Disconnect WiFi

Connects or disconnects WiFi. You must have the router’s SSID
and password and the radio’s IP address and IP port # set before
connecting to the radio.

Set router’s SSID. Touch to open the screen editor or use a

SSID terminal program connected to CTR2-Flex to set the SSID.
PW Set router’s password. Touch to open a screen editor or use a
terminal program connected to CTR2-Flex to set the password.
Enable or disable WiFi auto connect. When enabled CTR2-Flex
will try to connect to the WiFi network when it is first powered
AutoConnect

up. You can override this setting by pressing and holding the M5
button during boot.
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Flex Adrs

Set the radio’s IP Address. Touch to open the screen editor or
use a terminal program connected to CTR2-Flex to set the IP
address. The address can be found in the Settings -> Radio
Setup... ->Network tab in SmartSDR.

Flex Port

Set the radio’s IP Port. Touch to open the screen editor or use a
terminal program connected to CTR2-Flex to set the IP port #.

This is normally 4992 but you can change if you’re changed it on
the radio or are connecting to the radio from outside your LAN.

Import Settings

Import settings from a previously exported setting file using
XModem. In Tera Term select File->Transfer->XMODEM->Send
and select a previously saved settings file on your computer.
Next, touch Import Settings to start the transfer. See the Backing
Up and Restoring Setting section for more information.

Export Settings

Backup CTR2-Flex’s settings by exporting them to a file on your
computer. To do this, in Tera Term select File->Transfer-
>XMODEM->Receive then enter the name of the file you wish to
save. Next, touch Export Settings to start the transfer. Once this
file has been saved you can recover from a unintended memory
erase when flashing new firmware by using the Import Settings
option above.

NOTE: You can select to export just your unit’s basic settings or
the basic settings and all of the favorite frequency lists.

Info

Displays version #, call sign, and registration key. If the unit is
connected to WiFi the RSSl is displayed too.

10

Ring Mode

Selects the operating mode of the gray ring on the display. See
Ring Control Options for a complete discussion on Ring modes.

Rotate Screen

Rotates the screen 90 degrees for each selection. This allows the
screen to be aligned for various M5Dial mounting configurations.

Touch Delay

Enables or disables a 120-millisecond delay on touch input. This
can be used to reduce unintended touch events and occasional
randomly generated touch events from the M5Dial touch sensor.

11

Run CTR2-Dial

Select this option to switch to CTR2-Dial firmware on your unit.
CTR2-Dial uses Bluetooth or USB MIDI to control a 3™ party app
such as Marcus’ (DL8MRE) SmartSDR for iOS/Mac. It is not
compatible with SmartSDR for Windows. For more information
on CTR2-Dial refer to the CTR2-Dial Operation Manual.

Restore to Start
Up

This option allows you to reset your settings to what they were
when you first booted CTR2-Flex, if you didn’t choose to reset
your call and registration key in Reset to Factory. This is handy in
case you want to “roll back” changes you made during the
current session.

Demo Mode:
Edit Call & Key

Normal Mode:
Reset to Factory

In Demo Mode:

This option allows you to enter your call and registration key
without using a terminal program. To enter text, use the ring
encoder on the M5Dial or turn Knob A to select a character and
touch the display or press and turn Knob A to move to the next
character. Press OK to accept. You can also connect a terminal
program and use the terminal keyboard to enter your call and
registration key.

In Normal Mode:
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factory settings.

11 firmware registration key.

This option resets CTR2-Flex’s configuration back to the original
NOTE: You have the option of resetting your call sign and

NOTE: If you reset the configuration by mistake, and didn’t
choose to reset your call and registration key, execute the

powering the unit down.

Restore to Start Up option to restore your settings before

Dashboard

CTR2-Flex firmware includes a second method to control the radio called the Dashboard. To enter this

mode, select DashBrd from the Home menu.
Dash Home Page

The dashboard’s Home page displays the frequency along with
buttons to select various command groups.

The small inverted triangle above the caption indicates that CTR2-
Flex is connected to WiFi and to the radio.

When online the caption will display the active slice. Touch the

caption to open the Panadapter window to change the active slice.

Touch any element on this page to select or execute that item or
open its associated menu.

ANT1 10m 27k

28.074.000

RX use DSP
TX XARIT Misc

You can lock the VFO frequency by long-pressing any of the frequency digits. Unlock the VFO using the

same method.

The VFO frequency is always selected on the Home page as shown here. Turning the knob assigned to
<DAIL> changes the frequency by the selected step digit (the red digit, 1 kHz in this example). You can
change the step simply by double-touching another digit in the frequency or by pressing and holding the
knob assigned to <DIAL> then turning it CW or CCW. To select the % step (5, 50, 500, 5000, etc.) using

the touch method, touch the selected step digit again.

Knob Control

The selected parameter in the Dashboard can be adjusted by either swipe method (explained

next), or by turning the knob assigned to the <DIAL> function.

To use the knob on a CTR2-Uno (and older single-knob CTR2-Flex or CTR2-Dial) hardware, it
must be set to <DIAL> in the Knob menu. On CTR2-Duo (and older dual-knob CTR2-Flex and
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CTR2-Dial) hardware, Knob A is generally used as the dashboard parameter control knob, unless
you’ve changed its default setting from <DIAL> in the Knob A menu. On dual-encoder units,
Knob B can be set to <DIAL> in the Knob B menu and used as a dashboard parameter control
knob.

On CTR2-Quad hardware, any knob can be assigned to the <DIAL> function and then be used to
control the Dashboard’s parameters.

Swipe Method

When you touch an adjustable parameter in the dashboard, the selection indicator around the
that parameter turns red indicating that swipe adjustment is enabled. To change the
parameter’s value, simply swipe your finger to the left or to the right anywhere on the display.
On the dashboard Home page, swiping below the frequency is recommended so you can see the
frequency as you swipe. You can raise your finger and swipe again as long as the select indicator
is red. Swipe mode will automatically turn off after 3 seconds of inactivity.

To zero the digits below the selected tuning digit on the dashboard Home page, double-touch the Zero
button on the bottom of the page.

NOTE: If the VFO is locked (by long-pressing the VFO frequency digits), all frequency digits will be
“grayed out” and the Zero function will be blocked. To unlock the VFO, long-press the frequency digits.

To return to the controller’s Home page, press the M5 button on the M5Dial’s orange ring.
Touching the other buttons on this page will open their page. These pages will be described next.
Keypad Frequency Entry

CTR2-Flex has a built-in keypad for direct frequency entry. To open the
keypad, press Frq on the left side of the bottom button on the dashboard’s
Home page.

The current frequency will be displayed on the top of the display in Hertz with
the keypad below.

You can edit the current frequency by pressing the < button to delete digits to
be replaced then entering the new digits. In this mode you must enter all digits to 1 Hz and press the H
button to accept the new frequency in Hz. Be sure to add any trailing Os needed.

To enter a new frequency, press the X button to clear the current frequency, then enter the new
frequency. You can enter the frequency in MHz, kHz, or Hz. Once you’ve entered the new frequency
press the M, K, or H button to accept it. Use the < button to delete the last digit in the frequency.

Here are a few examples:

e Entering 10M sets the frequency to 10 MHz.
e Entering 28.074M sets the frequency to 28.074 MHz.
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e Entering 28074K also sets the frequency to 28.074 MHz (28074 kHz).

e Entering 2807400H sets the frequency to 2.807400 MHz. Add another 0 to make it
28.074 MHz.

e Entering 28074020H sets the frequency to 28.074020 MHz.

Touch Fav on the bottom-left button to open the Favorite Frequency page from this page.

NOTE: If the VFO is locked (by long-pressing the VFO frequency digits), this page is not available. Unlock

the VFO by long-pressing the frequency digits.

Antenna Page

The Antenna page allows you to select the antenna configuration on your Rxm
radio. Simply touch the antenna option you want to use.

ANT1 ANT2 XVTA
RX_A

Selecting XVTA (or XVTB on dual SCU radios) enables Transverter mode. This

mode adds the 2m, 1.25m, 70cm, 33cm, and 23cm bands to the Band page ANTI ANT2 XVIA

and compresses the frequency display to accommodate the additional digits.

The top half of this page displays the receive antenna options and the bottom
half displays the transmit antenna options. Touch a button to select an option.

When you're done, touch the Esc button at the bottom of the page to return to the dashboard’s Home
page.

Band Page

The Band button (top-center of the dashboard’s Home page) displays the current band setting on the
radio. Touch this button to open the Band page.

When either the XVTA or XVTB transverter options are selected in the Antenna page the 2m, 1.25m,
70cm, 33cm, and 23cm bands are added to the Band page.

160m 80m GOm 40m
30m 20m 17m 15m

12m 10m 6m 2m
125 70c 3%c¢c 22¢

Normal Band Options Additional Transverter Bands
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Touch Fav on the bottom-left button to open the Favorite Frequency page from this page.

Touch the Esc button at the bottom of the page to return to the dashboard’s Home page.

NOTE: If the VFO is locked this page is not available. Unlock the VFO by long-pressing the frequency
digits.

Filter Page

The current bandwidth is displayed in the top-right corner of the dashboard’s

Home page. Touch this button to open the Filter page.
Hi-Cut: 3480

On this page you can change the Hi-Cut and Lo-Cut frequencies Locut| 180 |

Offset: 0
independently and change the filter Offset to move the filter within the pass T —
band. The total bandwidth (3.3k) is indicated on a button at the center of the '

4™ row. Touch this button to step the bandwidth down to the next standard v

bandwidth for the selected mode. If the filter offset has been moved off-

center (40 Hz in this example) the Zero button is displayed. Touch this button to remove the offset and
reset the filter to its default settings.

The selected control (with the blue square) can be adjusted with the knob assigned to <DIAL>. You can
also enable swipe control by touching the selected control. The select indicator will turn red while swipe
is enabled. In swipe mode, simply swipe your finger on the display either to the left or to the right to
change the control. Swipe mode automatically turns off after 3 seconds of inactivity. Touching an
unselected control selects it. Touch it again to enable swipe.

RX Page
The RX page allows you to change several parameters related to the receiver.

Touch any control to select it. For variable controls, turn the knob assigned to
<DIAL> to change the setting. You can also touch the selected control to

P

AGC: med Gain: 0

continue to swipe until swipe mode times out (in 3 seconds). | . v

enable swipe mode, then swipe your finger left or right to change the
parameter. The select indicator will turn red while swipe is enabled. You can

Touch the AGC or Gain settings to step through the settings for those
controls.

The Volume control has a Mute function. Touch the Vol label to toggle mute on and off.

Touch ESC to return to the dashboard’s Home page.
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Mode Page

The Mode button (center of the dashboard’s Home page, below the
frequency) displays the mode setting on the radio. Touch this button to open

the Mode page. CW L8 [uss

AM FM RTTY

In the Mode page, touch a mode to switch the radio to that mode and return
_ _ DIGL DIGU SAM
you to the dashboard’s Home page. Touch Esc to return without changing the

mode.

DSP Page

The DSP page allows you to adjust and enable or disable each DSP setting on
the radio.

To adjust a setting, touch its gauge to select it then turn the knob assigned to
<DIAL>. You can also use the touch to select then swipe method described
earlier.

To enable or disable a control, touch the control’s label. When enabled the
control text will be inverted. Noise Reduction is enabled in this example. You can also select the
control’s gauge then touch the Tgl button to enable or disable that control.

Touch Esc on the bottom button to return to the dashboard’s Home page.
TX Page

Controls associated with the transmitter are accessed by touching the TX
button on the Home page.

PwRO 50 |

You can adjust the Power Out, Tune Out, and Mic Gain by selecting those TUNEO: 3 |

P -

ATU: TUNE Bypas

gauges.

The knob assigned to <DIAL> can be used to adjust the selected parameter or
you can enable swipe method to change it.

Both ATU buttons require one touch to select the tune function then a second touch (on EXEC) on the
left-bottom button to execute it.

To toggle the TX mode on the current slice, touch TX on the left-bottom button. The state of the TX
mode is indicated by the caption of the page (TX in this example). When TX is enabled the caption on all
pages will be red. When TX is disabled the caption on all pages will be the default background color.

You can also open the Buttons menu to change TX mode on the radio. If you use it a lot you can assign
the Tx Enbl button on the Buttons page to one of the knob switches.
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Touch Esc on the bottom button to return to the dashboard’s Home page.

X/RIT Page

Enter the X/RIT page by touching the X/RIT button on the dashboard’s Home
page.

As with the other control pages, select a control then use the knob assigned to
<DIAL> or the touch to select then swipe method to change the control’s
value.

Enable and disable the selected control by touching the control’s label or by
touching Tgl on the bottom button.

When a control is not set at 0 Hz, a Zero button will appear below its gauge. Touching this button sets
the control to 0 Hz.

Touch Esc on the bottom button to return to the dashboard’s Home page.

NOTE: If the VFO is locked this page is not available. Unlock the VFO by long-pressing the frequency
digits.

MISC Pages

The Misc page contains several sub-pages. These pages include the Keyer Settings, CW Macro Selection,
Panadapt1/Slice Settings, and Panadapt2 pages.

Touch PG> on the bottom button (if available) or turn the gray ring on the M5Dial to move to the next
page.

These pages will be described next.

Keyer Setting Page

The keyer’s settings can be changed in this page. As in the other dashboard v m

pages you either use the knob assigned to <DIAL> or touch to select it then

use the swipe method to change th lue. Changing the Speed setti ecin |
gtf_' e value. Changing e‘ peed setting ' Dae il % |

changes the speed for both the internal keyer on the radio and the keyer in sdTone] 40|

CTR2-Flex.

Type: lam-A  Breakin

The radio’s sidetone can be enabled or disabled by touching the SdTone label W
or the Tgl label on the bottom button. There is a physical volume control on

CTR2-Flex hardware to adjust the sidetone volume.

NOTE: The radio’s sidetone is only available when your paddles are connected directly to the
radio and you’re using the radio’s internal keyer. It is not available when keying the radio with
CTR2-Flex over the network.
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The Breakin button controls the radio’s breakin mode.

NOTE: To key the radio, you must have Breakin enabled (as shown in photo above) and the
current slice must have TX enabled. The caption will be red when TX is enabled.

The knob assigned to <DIAL> can be used to adjust the selected parameter or you can enable swipe
mode to change it.

You can step through the keyer Type by selecting Type then pressing the Chng label on the bottom
button or by pressing the Type label again once it is selected.

When SdTone and Type are not selected, touch Pg> on the bottom button to open the
Panadapter/Slice page. You can also turn the gray ring on the M5Dial CW to move to the next or
previous page if the Ring mode is not in Sync2Dial or Selected Control.

Marco Select Page

This page allows you to select, play, and edit one of the nine CW macros.

Macros are listed using the first 5 characters of each buffer. Touch a macro to - ‘m
cqcq Tnxf qthi

select it then touch Play to start it or Edit to edit it.
name rigi sohw

. sohw Mac8 This

Once you start a macro the button options change to Pause, Stop, and Add.
Edit

Touch each button as required. Once a macro has started you can leave this :

page and let it run.

Touch Pg> on the bottom button or turn the gray ring on the M5Dial CW to
open the Panadapter/Slice Settings page or turn it CCW to open the Keyer Settings page.

Touch Esc on the bottom button or the M5 button on the orange ring to return to the dashboard’s
Home page.

Macro Edit Page

Pressing the Edit button on the Macro Select page opens the editing page for [ R
MACRO #1 N\
the selected macro. 'Cq cqcq de ™

Acq cq cq de

e Turn the knob assigned to <DIAL> to change the selected character kN

e Touch the screen to move the cursor to that location
- Or -

e Press and hold the knob assigned to <DIAL> down then turn it to
move the cursor to the next character

e The A character is used to insert your registered call into the buffer

e Use the Ins and Del buttons to insert or delete a character

e Touch OK to accept the changes or Esc to exit without changing the buffer
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NOTE: You can also edit the macros using a dumb terminal such as Putty or Tera Term on a Windows

PC or the built-in terminal program in a Mac or Linux. Simply press the # of the buffer to edit (1 to 9)
in the terminal.

Panadpt1/Slice Page
The Panadptl/Slice page allows you to change the ranges used on the e ooen
panadapter and select which slice you want CTR2-Flex to control.

Zoom(ky 200 |
You can access this page directly from the dashboard’s Home page by PanMax 40 |

- - Panbin 135 ]
touching the caption on the Home page.
Slice A < >

The normal methods to change the selected value are available, i.e. turn the W

knob assigned to <DIAL> or touch then swipe.

To change the Slice, touch either the < or > button. The new Slice character will be displayed inverted.
To accept the change touch Chng on the bottom button. The controller will disconnect from the radio
and then reconnect to the new slice.

To move to the Panadpt2 page touch the Pg> button or turn the gray ring on the M5Dial CW. To move
back to the Macro Sel page, turn the gray ring CCW.

Touch Esc on the bottom button to return to the dashboard’s Home page.

Panadpt2 Page

The second panadapter page allows you to control the Average, Gain, and
Black levels on the panadapter and waterfall. ANADPT2
PanAvg: 50 |

The two buttons on the 4™ row allow you to toggle Weighted Average and PanGn{___ 30 |

Auto-Black functions. 0

Wght Avg Auto Blk
These functions are also available on the virtual Dial control.

Favorite Frequency Page

Access the Favorite Frequency page by pressing Fav on either the Keypad or
Band page. This page displays 10 frequencies that you have visited.

357300 210740U*

707400 249150U*

In the Settings menu you can select to save frequencies from all bands to one 1013600 280740 U*
list (shown in this screenshot) or you can have a favorited frequency list for 140740U* 50313.0U*

each band. 181000U* 140542C

D\ Lock | Esc A

this list when you stop on a frequency for longer than 10 seconds. Modes are represented by their first
letter, U=USB, C=CW, etc.

Frequency and modes are automatically added to the first unlocked bin on
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Lock a frequency bin by selecting it then touching Lock on the bottom-left button. Locked bins have an
asterisk to the right of the mode character. Once locked the bin will not be overwritten by new
frequency or mode data. This allows you to freeze your favorite frequencies and quickly return to them.
Unlock the selected bin by touching UnLk on the bottom button.

Touching any frequency bin will highlight that bin and automatically tune the radio to that frequency
and mode (if CTR2-Flex is online). The bin will be highlighted with a red outline for 3 seconds and Move
will appear on the bottom left button. During this time, touching Move will move the selected bin to the
top left position. This allows you to organize your frequency list.

Turn the knob assigned to <DIAL> to move to another bin. Favorite frequencies will be restored after a
power cycle. Once all of the bins have been locked the list will not accept new frequencies.

Touching a frequency twice will return you to the dashboard’s Home page.

Press Esc to return to the dashboard’s Home page.

Backing Up and Restoring your Settings

Once you have your CTR2-Flex setup the way you want it, go to the Settings

page and Export your settings to a backup file on your computer. ¢ m
Impornt Settings
CTR2-Flex uses the XModem file transfer protocol to transport settings to Expont Settings

and from backup files on your computer. XModem is an older protocol and
not many dumb terminal programs support it anymore. Tera Term does and W
I'll use it in the document. Putty does not. To get XModem functionality with

Putty you need to download and install ExtraPutty. This program is a branch
of Putty. You can download it from here.

Before you can use the Import Settings option you must export the settings on your CTR2 unit once
you’ve made changes. If you want to just return to factory settings, select the Reset to FACTORY option
in the Settings menu.
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Export Settings

To export the current settings in CTR2-Flex, connect
Tera Term to your CTR2 unit then open its XModem
transfer utility. This can be found at Files->Transfer-
>XMODEM->Receive... option shown here.

When you select this option Tera Term will ask you to
enter the file name for the file you want to create.
Navigate to the folder you want to save it in then give
it a name. | prefer to use the .txt extension but you
can use any extension you want.

NOTE: If you don’t enter an extension, your file will
not have one, which can confuse Windows.

When you click OK Tera Term will open the XModem

New connection...
Duplicate session

Cygwin connection

Log...

Send file..,

Transfer

COM11 - Tera Term VT
Edit Setup Control Window Help

Alt+M
Alt+D
Alt+G

he Settings start
your terminal.
Import settings
Receive to Export
your computer.

Kermit

Change directory...
Replay Log...

TTY Record
TTY Replay
Print...

Disconnect

Exit
Exit All

Alt+P

Alt+l
Alt+Q

,
XMODEM 5] | rReceive.. |

Y¥MODEM > Send..,
ZMODEM »
B-Plus »
Quick-VAN »

transfer window and wait for the transfer to start. At this point, touch the Export Settings option in the

Settings menu.

You can select whether to send just the basic configuration of you unit, or a full system backup that

includes all of the radio and frequency information (including your WiFi credentials and radio address). If

you plan on sharing your configuration with others, | recommend saving just the basic configuration.

The transfer should complete in a second or two and you should have a new file in your backup folder.

You can view this file with a text editor. | don’t recommend editing the values in this file because invalid

values may cause problems with CTR2-Flex’s boot process.
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Import Settings

Now that you have a backup file of your settings (or have downloaded a configuration file from the

Lynovation web site) you can import them using the Import Settings option.

To start an import, touch the Import Setting button in
the Settings menu. Next, in Tera Term, navigate to the
File->Transfer->XModem and select the Send option.
Tera Term will ask you to select a file. Select one of the
files you previously exported, or a file from the CTR2-
Dial Configuration File zip file. Tera Term will then

open the file transfer window and transfer the file.

HINT: You can use the export and import settings
functions to save and reload multiple versions of your
settings. Perhaps you use CTR2-Dial on more than two
apps and have each app configured differently. You
can export the settings for each of your apps then
import them back in when you want to change apps.

New connection...
Duplicate session

Cygwin connection

Leg...

Send file

Transfer

& CcOM11 - Tera Term VT
File § Edit Setup Control Window Help

Alt+N
Alt+D
Alt+G

>

he settings start
your terminal.
Import settings
Receive to Export
your computer.

Kermit

Change directory...
Replay Log...

TTY Record

TTY Replay

Print...

Disconnect

Exit
Exit All

Alt+P

Alt+]
Alt+Q

XMODEM > Receive...
Y¥MODEM »
ZMODEM >
B-Plus ¥
>

Cuick-VAN

This is also handy if you have more than one CTR2 controller, or if you want to share your configuration

with other users.

NOTE: If the file transfer stalls (as shown here), cancel the transfer in Tera

Term and run it again. This seems to be a random bug in Tera Term as it

doesn’t happen all the time. The import function in CTR2-Dial will timeout

after 30 seconds if the transfer doesn’t complete.

Using ExtraPutty

If you use the XModem transfer option in ExtraPutty
as shown here, use the Xmodem option, not the
Xmodem 1K option.

& COM11 - PuTTY

Tera Term: XMODEM Send

Filename: [CTR2-Dial_SmartSDR,

Protocol: XMODEM [CRC]

Packet#: 1

Bytes transferred: 128

Elapsed time: 0:00

| 1.9%
Cancel I

Vmodem B
Zmodem

TFTP
FTP

00:06:19 Connected  SERIAL/1152008N 1 Error File not found !
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Flex Radio CW Zombie Mode

Occasionally the Flex radio exhibits an odd problem when keying over the network. The radio can go
into what | call CW zombie mode. This happens occasionally when connecting and disconnecting
multiple clients to the radio that send remote keying commands (at least | think that’s what causes it).

In zombie mode the radio looks like it is transmitting CW, the light on the front panel turns red, the TX
icon turns red, the MOX button turns blue but no RF carrier is generated or displayed on the
panadapter. The only way | have found to get the radio out of zombie mode is to disconnect all clients
and power cycle the radio.
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Appendix A: Installing or Updating CTR2-Flex Firmware

CTR2-Flex firmware is pre-installed on assembled CTR2 units supplied with the M5Dial controller. If
you’re using your own hardware, you’ll need to install the firmware yourself.

Starting with v2.00.00, CTR2-Dial firmware became part of the CTR2-Flex firmware package. As of
v2.03.05, CTR2-Flex/Dial firmware is now distributed as a single BIN file. This simplifies the installation
process and reduces the possibilities of entering the wrong offset address for individual BIN files. The
address of the single BIN file always starts at 0x0. Instructions for switching between the two firmwares
can be found here.

Before you begin, download the latest CTR2-Flex/CTR2-Dial firmware from my web site. Unzip the
firmware distribution zip file into a folder.

Installing Firmware using ESPConnect (New Method)

By far, the easiest, and recommended method to install or update firmware on an ESP32 process is with
ESPConnect, an open source ESP32 management project.

ESPConnect is a browser-based tool that must be opened on a Chromium-based browser that supports
Web Serial, such as Chrome, Edge, Brave, or Opera. It will run on a Windows PC or an Apple Mac.
Unfortunately, Linux doesn’t support Web Serial in any browser.

To start, open ESPConnect here: https://thelastoutpostworkshop.github.io/ESPConnect/

< C [(wn] @ thelastoutpostworkshopgithub.io/ESPCannect/

Baud rale
o Eisff"""ed 921600 ENGLISH =

SECTIONS

@®  Device Info

Next, plug your CTR2 unit into a USB port on your computer.

NOTE: Do not connect it to an unpowered USB hub. thelastoutpostworkshop.github.io wants to connect to a
serial port

Click the Connect button.

FabulaTech_VirtualPort_103 (COM104)

Brother MFC-7860DW Remote Setup Port (COM13)

A device list will pop up showing the available USB
devices on your computer. FabulaTech_VirtualPort_03 (COM4)

TinyUSB Senial (COMTY) - Paired
On a Windows PCs, all CTR2 units will be shown as a

TinyUSB Serial device, as shown here.

On Macs, CTR2 units based on the M5Dial will be
listed as an M5STACK_DIAL device.

Select the CTR2 device and click the Connect button.
C t Cancel
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A popup warning will appear telling you that an error occurred. Some Processing Error
errors may tell you to press the BOOT button on the processor to put

An error occurred while processing information from the

device.

it into bootloader mode. You do not need to do this.

Last error- Couldn't sync to ESP. Try resetting manually. Last

error- Cannot write during port reconfiguration

This is the normal response when trying to connect to a Tiny USB serial device.
Click the Connect button on the home page again.

This time, the TinyUSB serial (or M5STACK_DIAL on thelastoutpostworkshop.github.io wants to connect to a
i ; ial port

Macs) will not be shown on the list. Instead, a new =l
device, USB JTAG/serial debug unit will be shown (on FabulaTech VirtualPort_103 (COM104)

both PCs and the Mac). Brother MFC-7860DW Remote Setup Port (COMT13)

ici o FabulaTech_VirtualPort_03 (COM4)
This is the bootloader port and the unit is now ready

to program USB ITAG/senal debug unit (COM9) - Paired
Select the USB JTAG/serial debug unit device then
click Connect.

NOTE: Apparently, not all ESP32-S3 processors will
enable the USB JTAG port automatically. If your’s

doesn’t, you’ll need to open the enclosure an press Cancel
the Programming button on the back of the M5Dial.

Once you're connected to your CTR2 unit, the left menu items on the page will be enabled.

<<< WARNING >>>
ESPConnect is a powerful device editor. Many of the functions can cause problems with CTR2 firmware
if you change them. If you don’t know what a functions does, DON’T CHANGE IT!

Click on the Flash Tools menu item and scroll down to the Flash Firmware section.

Click the Firmware
4 Flash Firmware

binary (.bin) text box.

A file navigation screen will appear. Navigate to where you unzipped the firmware zip file from the
firmware update page and click on the CTR2-Flex.bin file.
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Your display should

4 Flash Firmware

now look like this: e —
B CTR2-Flex bin 0x0

Leave the Flash offset
set to 0x0 and
uncheck the Erase
entire flash before
writing checkbox.

Recommended offsets

[] Erase entire flash before writing

Flashing runs at 921,600 bps by default. Drop the baud if the device siruggles fo sync. The serial monitor automatically iches fo 115,200 bps for stability.

4 FLASH FIRMWARE

Click the FLASH FIRMWARE button to start the flash process.

Once the process completes, cycle the power on your CTR2 unit. The version # will be displayed when
the unit boots. The version # should match the version # from the firmware zip file.

This completes the firmware update process.

Installing Firmware using EspressIF Flash Download Tool (0Old Method)

The EspresslIF Flash Download Tool is the original flash tool provided by the makers of ESP32 micro
controllers. It's geared for developers and many find it difficult to use.

This section will describe the process of using this tool to update your M5Dial. | highly recommend using
ESPConnect, described above, instead.

Download Button Reset Button

You must force the M5Dial into programming mode before you
can flash firmware to it. To do this, follow this procedure

1) Open the enclosure and locate the back of the M5Dail
a. On 3D printed enclosures remove the four screws
holding the base to the shell with a 2mm Allen
wrench
b. Onthe New Age enclosure remove the four rubber
feet on the bottom by pulling them off then
remove the four Phillips screws under the feet
2) Press and hold the DOWNLOAD (BTN) button on the M5Dial then apply power to CTR2-Flex. The
display will be blank when the unit boots into programming mode. If the unit is already powered
up, press and hold the DOWNLOAD button then press and release the RESET button. You should
hear a beep from your computer as it registers the new USB COM port and the display will be
blank.
NOTE: If you have problems getting the DOWNLOAD button to work its lever may have slipped
off the button on the board. Remove the label and flick the lever back onto the button. Thanks
Joe, KO8V for the tip!
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3) You can now use the procedure below with EspressIF Flash Download tool (on Windows) or run
the script (on Linux and Mac) with the new COM port to flash the new firmware to the M5Dial.
4) Once the download completes, cycle the power on the unit to start the new firmware.

Now that you have the M5Dial in programming mode, follow these steps to install or update to the
latest CTR2-Flex/CTR2-Dial firmware:

1. Download and unzip the latest CTR2-Flex firmware from my web site. Unzip that file into a
different folder than where you store other Lynovation firmware update files.

2. Download and open the EspressIF Flash Downloader Tool. When it

[N DOWN.. — =] X
starts, select the ESP32-S3 Chip Type. Leave WorkMode set to
Develop and LoadMode set to UART. Chipfype:  ESP32-53 ¥
WorkMode: Develop v
LoadMode:  UART N
oK

3. Map the CTR2-Flex.bin file that you unzipped from
the CTR2-Flex_v2.xx.xx firmware distribution file into

the downloader tool and set the offset address to :
0x0. @
@
- - @
. O
4. Select the checkbox on the left of the CTR2-Flex.bin |:: Z
filename as shown. o - @
O - @
] - @
. SPIFlashConfig
5. Set the COM: port to the port assigned to CTR2-Flex SPISPEED  SPI MODE Detectedinfo
© 40MHz Oaqio 8 DoNotChgBin
and set the Baud: to 921600. g ) )
O267MHz O QOUT LockSettings
O 20MHz [« ol[6} Combined
NOTE: You must use a USB-C data cable. -C (O e Defautt
. () FASTRD

charge-only cables (supplied with may devices)
not work.

DownloadPanel 1

COM: | [y v
BAUD: 921600 v

START STOP ERASE

6. On new installs, click the ERASE button to clear the factory demo from the M5Dial’s memory.

NOTE: If you erase the memory after running the CTR2-Flex firmware you will need to re-enter
your call sign and registration key, re-select the number of knobs on your unit, and re-enter

your WiFi and radio settings the next time you start CTR2-Flex. If you previously exported your
settings, you can restore them using the Import Settings option in the Settings menu.
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7. Click the START button to download the firmware.

8. Once the download is complete, cycle the power on the unit to start the new CTR2-Flex
firmware.

NOTE: The ESP32-S3 processor will revert back to its operating COM port after the reboot.

Installing using Linux or Mac

Mac users should use the new method using ESPConnect, described above. Linux users have no other

option, other than to follow the procedure below.

A script file is supplied in the firmware update zip file. This script file can be used in a Linux or Mac
environment if you don’t have access to a Windows computer.

Instructions for using this script file are include in the CTR2-Micro Operation Manual in Appendix B.

The firmware that allows USB MIDI control changes the way the virtual COM port works on the ESP32-
S3. One COM port is used in the normal operating mode and another COM port is used for flashing the
firmware. In order to flash new firmware to the unit you must force the ESP32-S3 to switch from the
normal operating mode to programming mode.

To use the script file:

1) Force the M5Dial into programming mode as described above.

2) Edit the COM port in the script to the programming port. This port will be different than the
operating COM port.

3) Edit the path to the .BIN file in the script.

4) Run the script.

Appendix B: Configuring Tera Term
On Windows, Tera Term is the simplest terminal program to get running for a serial connection.

If you search for Tera Term you find a lot of garbage with malware attached to it. I've downloaded a
clean copy of Tera Term v4.106 and posted it in the CTR2 Group 10 files section. You can download it
here. As far as | know, Tera Term is only available for Windows.
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When you first open Tera Term you'll

Tera Term: Mew connection

be presented with the Tera Term ~

. . ) O TCPIP
New connection window. Simply History

o . 23
select the Serial radio button, select Telnet

. . SSH
the COM port Window’s assigned to o sz
Er
your Micro when you plugged it in, AUTO
and click the OK button. O Serial Port: [COM3: Brother MFC-7860DW Remote - |
COM3: Brother MFC-7860D% Remote Setup Port [COM3)
. . COMA: FlexRadio ¥irtual Serial Port [COM4

Since you are connecting to a USB COM19: USB Serial Device [COM19

e rEssem— COM104: FlexRadio Virtual Serial Port [COM104)

serial port there is no need to set the
baud rate. It will run at USB speed regardless of the baud setting.

That’s it! Tera Term should now connect to CTR2-Flex. Once connected, press any key to start CTR2-

Flex’s terminal server.

You can change the terminal size in the Setup menu. Select Terminal... Set the Terminal Size to 41 x 20.
CTR2-Flex’s terminal interface was designed for this size.

While in the Terminal... settings verify the New-line options are set to CR for both Transmit and Receive
and the Terminal ID is set to VT100.

You'll probably want to change the font size and colors. These are also changed in Tera Term’s Setup
menu. Select Display to change the font and background colors to your liking. Select Font to change the
font and font size. | like Courier New, Regular, and 14-point size. Your preferences may differ.

Once you have the program configured the way you like, select the Setup->Save Setup... menu and save
your configuration. If you use the default file name, TERATERM.INI the program will automatically start a
Telnet session using the COM port you selected above when it opens. This provides one-click access to
your CTR2-Flex firmware.

Appendix C: Configuring Putty

Putty is a terminal program that can be configured for a variety of needs. CTR2 controllers based on the
M5Dial only supports serial connections. This section describes how to configure the program to
interface with CTR2-Flex.

NOTE: Putty does not have XModem transfer capability. If you want to export and import backup files

for CTR2-Flex’s settings, consider using Tera Term or install ExtraPutty.

Download Putty for Windows from https://www.putty.org/. It’s also available for Linux at

https://www.ssh.com/academy/ssh/putty/linux and for Mac at

https://www.ssh.com/academy/ssh/putty/mac.

You'll need to connect to CTR2-Flex using its USB serial port in order to configure it. Make sure to use a

USB data cable, not a “charge-only” supplied with many USB-C devices.
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Serial Session

Select Serial then set the Serial Line to the COM Basic options for your PuTTY session

port you found in the Device Manager and set Speciy the destination you want to connect to

Speed (Baud Rate) to 115200. Serial line Speed
COoOM19 115200

NOTE: Since this is a USB serial port the Speed Connection type:
(baud rate) doesn’t matter. Data will be sent at (ORaw (O Telnet (CRlogin (0SSH ©
USB speeds regardless of the Speed setting.

Next, select the Terminal item and set the Implicit E& PuTTY Configuration
LF in Every CR to on, and Local Echo, and Local Line | =¥ : : : :
- Session ions cortroling the temminal emulation
E| S: Opt ntrolling the t | Eit
Editing to Force Off. gging Set various terminal options
. ”Kefboard @ Auto wrap mode initially an
. . . . Bell [_J DEC Origin Mode initially on
You can change the window size under the Window - Features (O Implicit CRin every LF
H = Window B Implicit LF in every CR
item. Set the Columns to 41 and the Rows to 20. - Appearance (] Use background colourto erase screen
- Behaviour (] Enable blinking text
gralnslation Answerback to “E:
[+~ Selection
- Colours PuTTY
(=1 Connection Line discipline options
- Data .
- Proxy 8:;[:cho. OF or -
Telnet Lo .0 - orce on arce
_ cal line editing:
EJ glsofim O Auto () Force on O Force off
- Serial Remote-controlled printing
Printer to send ANSI printer output to:

About Help Cancel

Next, select the Keyboard menu option and note I8 PuTTY Configuration
the setting for the Backspace key. If Control-H is
selected you will need to press Ctrl+Backspace to
send the Del key (ASCII 127). If Control-? (127) is
selected, press the Backspace key to send the Del
key code.

Options controlling the effects of keys
Change the sequences sent by:

The Backspace key
© Control-H (O Control-? (127)

Saved Sessions

Once this has been done, return to the Session menu item, enter a CTR2-Dial
name for this session and click the Save button. This allows you to Dol Jetings Load

easily re-open this session with just a couple of clicks. v

CTR2-Micro_Dev1
CTR2-Mini Delets

If you right-click on the Putty icon in the Windows toolbar the last Plex Server
few sessions you had open will be displayed. Just select the one you want to open it.
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You can adjust the display colors on the Windows->Colours menu item. The Micro uses the Bold
attribute to highlight the hotkeys and other items. | like to set the Background color to blue and the
Bold color to yellow but you can find the colors that work for you. After you get a color combination you
like return to the Session menu and Save the session.

Appendix D: Apple or Linux Terminal Programs

The Apple Mac and Linux have built-in terminal programs so there is no need to install a separate app.
To connect your CTR2 unit to a terminal session use the following process.

First, list your current serial ports without your CTR2 unit plugged in.

e On the Mac open Applications/Utilities/Terminal.app. On Linux open the terminal program
supplied by your distro.

e Onthe Mac, enter Is -l /dev/tty.usb*, on Linux, enter Is /dev/tty* This will return a list of all
known serial ports.

e Next, plug CTR2-Flex into the computer’s serial port and execute the command above again.
This is easily done by pressing the Up arrow key.

e Compare the new list with the old list. CTR2-Flex’s serial port ID will appear on just the new list.
For Mac users the serial port ID format will be /dev/tty.usbserialxxxxx where xxxxx is a unique
device ID #. Linux users will see something like /dev/ttyACMXx or /dev/ttyUSBx, where x is a
unique # for that port.

NOTE: If a new virtual serial port is not created when you plug your CTR2-Flex into your PC make sure
you are using a USB-C cable that supports data. Many USB-C cables only provide power to the remote
device.

Once you know your CTR2 unit’s USB serial port ID, write it on the label on the bottom of the unit using
a fine-tipped permanent marker for future reference. Put a piece of transparent tape over the label to
seal the ink so it doesn’t rub off (it's not as permanent as you think). You can always remove the tape if
you want to change what’s written on the label.

Once you have the serial port ID, enter the following: screen {serial port ID} 9600. Include the complete
device description (i.e. /dev/ttyxxxxxxx) for the serial port ID. This will open the serial port using 9600
baud in a terminal session. The following screenshots demonstrate these steps.

1. Get the list of serial devices on your computer. We’re looking for the usb device.
r. ] = lynn — -zsh — 84x24

Last login: Fri May 3@ @9:56:14 on ttys@@e =
lynn@PLynns—-Mac-mini ~ % 1ls —al Sdev/tty.#*
crw—rw—rw— 1 root wheel @x%800802 May 29 14:29 fdev/tty.Bluetocoth-Incoming-Port

crw-rw-rw—- 1 root wheel @x%008888 May 29 14:29 =
crw-rw-rw—- 1 root wheel @x7000084 May 38 10:88| fdev/tty.usbmodem3144481

lynnPLynns-Mac-mini ~ %
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2. Open the screen utility using the usbmodem31444-1 device. Your USB device will have a
different numerical #.
@ (] = lynn — -zsh — 84x24
Last login: Fri May 3@ @9:56:14 on ttys@ea 1=
lynn@Lynns—Mac-mini ~ % ls -al /dew/tty.#

crw-rw-rw— 1 root wheel @x98800882 May 29 14:29 Sdev/tty.Bluetooth-Incoming-Port
cru-rw-rw— 1 root wheel Bx9800088 May 29 14:29 Sdev/tty.debug-console

crw—-rw-rw— 1 root whee odem3144481
lynniLynns—Mac—-mini =~ %|screen fdew/tty.usbmodem3144481 9688.

3. Thisis CTR2-Flex’s terminal display. Press the indicated key to edit each field.

[ ] @® [ lynn — screen [dev/tty.usbmodem24587C5CDADC1 9600 - SCREEN — 84x24

WIFI SETTINGS MENU

1 to 9) Edit CW Macro
A} WiFi Router SSID: <Net Set>
B) Router Password: <Not Set>
c) Radio's IP Adrs: <Not Set>
D} Radio's IP Port: 4992
(Default is 4992)

Press macro # or item to change

DEMO Mode: Press Backspace or Del
to enter call & license ksyl

Appendix E: Power Requirements

The approximate current on an M5Dial equipped CTR2 unit’s USB connection is shown below for

various

configurations. If you’ve installed the 3.7-volt lithium battery option, these numbers will help you

determine the length of time your unit will run on the battery. The M5Dial doesn’t have the hardware

necessary to monitor the battery’s state of change, so you won’t know when the battery is about to be

depleted.

WiFi Mode Backlight Current
High 170 mA

on Medium 2 152 mA
Medium 1 133 mA

Low 115 mA

High 121 mA

Off Med?um 2 105 mA
Medium 1 82 mA

Low 70 mA
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Appendix F: Change Log

Changes applied to older firmware versions are documented here.

v2.03.06: December 26, 2025
e Additional work on paddle debouncing to eliminate random code elements

v2.03.05: November 10, 2025
e Firmware is now released as a single .BIN file instead of four .BIN files

e Added information on switching between CTR2-Flex and CTR2-Dial firmware modes

e Added paddle release debounce to fix issues with cheaper paddles adding extra code elements
e Improved keyer Bug mode so it works properly now
e Fixed several bugs in the Export and Import Settings functions

o  WiFi credentials and radio IP settings are now encrypted in exported settings files

v2.03.04: October 9, 2025
e Fixed a bug that caused Dial/Flex modes to switch when running unit on lithium batteries
e Fixed a bug that caused the frequency display to appear whenever a VFO knob is turned
e Added CW Macros 1 to 5 and Macro Stop to Flex mode’s Button menu
e Removed Keyer Weight in Flex mode (not used) — replaced with Sidetone Pitch control

v2.03.03: September 16, 2025
e Added Touch Delay On/Off to Setting menu to enable or disable the 120-millisecond delay on
touch events that was added in v2.03.02
e Display selected Rx antenna on the dashboard home page

v2.03.02: September 10, 2025
e Added 120 mSec debounce to screen touch — Some M5Dials send random touch events
e NOTE: v2.02.01 was released for one day but had bugs in the debounce code

v2.03.00: September 4, 2025
o Fixed major bug causing radio to reset when disconnecting CTR2-Flex from WiFi
e Added option to save favorite frequencies per band or for all bands
e Added Edit Call & Key option to Setting menu — allows you to enter your registration credentials
without a terminal program

v2.02.00: August 18, 2025
e Added Ring Control options — you can now assign a dial function to the gray ring encoder on the

display

e Removed the Mono option on the Dial menu and replaced it with LnO-Gn (Lineout Gain) to set
external speaker drive.

e Documented how to set up you CTR2-Flex to use an external keyer and/or hardware PTT switch

on the Paddle Input jack.
e Added a VFO Lock option
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v2.01.01: August 10, 2025
e You can now choose if you want to reset your call and registration key in the Reset to Factory

option.

v2.01.00: August 7, 2025
e Added extended frequency support for transverters. Selecting XVTA or XVTB on the Antenna
page in the dashboard adds 2m, 1.25m, 70cm, 33cm, and 23cm bands to the Band page.
e Fixed a bug that was causing unpredictable control states on radios with multiFlex enabled.
e Removed the Knob A double-click to toggle the radios’ TX mode and now allow the switch on
Knob A (and Knob B on dual-encoder units) to be assigned to execute any Button function.

e Rearranged the Antenna, Band, and Mode pages in the dashboard.
e Added a new link to download Tera Term. Get it from the CTR2 Group IO File folder here.

v2.00.00: July 24, 2025
e Combined CTR2-Dial firmware with CTR2-Flex firmware
o Firmwares are independent of each other
o If you migrate from CTR2-Dial v1 to CTR2-Flex v2 firmware your settings from CTR2-Dial
v1 will be applied to CTR2-Dial v2 and be available when you switch to CTR2-Dial mode
o This manual covers the CTR2-Flex firmware — see the CTR2-Dial Operation Manual for

CTR2-Dial firmware information
o Select which firmware to run in the Settings menu
o This firmware is compatible with both CTR2-Dial and CTR2-Flex hardware
e Added toggle TX control of the current slice to the CTR2-Flex Dashboard — Tx page

v1.01.00 - July 21, 2025
e Added additional information to Appendix A on preparing CTR2-Flex to flash firmware

v1.01.00 - June 28, 2025
e Added Favorite Frequency page to Keypad and Band pages

e Start on WiFi Connect when starting without WiFi AutoConnect enabled
e Bumped v1.00.09 to v1.01.00 since Favorite Freq is a feature addition

v1.00.08 - June 16, 2025
e Added formatted frequency display to Dial VFO control
e Added double-click to toggle TX enable mode on/off
e Darkened Orange and Green theme colors for better contrast

v1.00.07 - June 9, 2025
e Added Panadapter Page 2 to the Misc pages to add controls for the panadapter and waterfall —
these are also included in the virtual Dial menu
o Added Average, Gain, and Black level controls
o Added Weighted Average and Auto-Black buttons
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e Added a Mute function to the Volume control

v1.00.06 - June 4, 2025
e Added a Breakin button to the Keyer menu to control breakin mode
e Caption now shows if transmit is blocked because TX is not enabled or keyer is not in breakin
mode
e Bug fix: not saving radio settings when changing slices

v1.00.05 - June 3, 2025
e Don’t force keyer mode on radio to Straight if not in CW mode or TX is not enabled

v1.00.04 - June 1, 2025
e Fixed bug that was causing multiple controllers to follow the frequency of the slice that had Tx
enabled
e Added Tx Enable control to enable Tx in the selected slice
o Added Tx Enbl to page 4 of the Buttons menu
o Press and release Knob A to toggle Tx Enable on any screen
o The screen caption text turns red when TX is enabled

v1.00.03a - May 30, 2025
e Added Appendix D with information on using the screen command in Mac and Linux for a
terminal interface

v1.00.03 - May 23, 2025
e Fixed bug in reverse Knob A/B so press & turn Knob A changes frequency step
e Display selected slice as caption in Dashboard Home page

o Touch Dash Home page caption to open Panadapter page to change selected slice
e The parameter values now follow changes made in SmartSDR

v1.00.02 - May 18, 2025
e Fixed bugin v1.00.01 that was blocking WiFi connection

v1.00.01 -May 17, 2025
e Fixed bug in Dashboard Panadapter controls — swipe to change wasn’t working

v1.00.00 - May 15, 2025
e Fixed bugs with Swap A/B option when using it on CTR2-Dial hardware

v1.00.00aq - May 10, 2025
o Allow Knob B to change knob functions in the Knob menu.
e Added hint on getting to Programming Mode

v1.00.00ao0/ap - May 3, 2025
o Added Backspace key to start registration entry and added note about DEL key mapping in Putty

e Automatically enable swipe tuning when selecting a frequency digit in the Dashboard Home
page.
e Added double-touch to turn on swipe adjustment mode on Dashboard pages to accept swipe

actions
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e Added [Knobs: Swap A/B] option

v1.00.00am - May 1, 2025
e Added left/right swipe to the Dial control and the Dial, Knob, and Buttons menus to switch
between pages.

v1.00.00al - April 28, 2025
e Updated all control graphics to match new control graphics in CTR2-Dial
e All controls are now speed sensitive
e Added a new keypad for direct frequency entry to the Dashboard

v1.00.00ae - March 30, 2025
e Added on-screen editing for WiFi SSID, password, radio IP address and IP port
e Display virtual dial when changing settings in dashboard
e Moved dashboard Keyer page in front of Macro Select page
e (Can use encoder to select keyer macro to edit — turn to change, press to edit
e Added an Info button to the Settings menu. It displays version #, call, and registration key

v.1.00.00ac - March 11, 2025
e Added touch & hold to dashboard VFO to unselect it so knob can be used for other settings

v1.00.00aa - March 9, 2025
e Added a new Filter page to the dashboard
e Swapped bandwidth and mode button locations on Dash Home page

v1.00.00 - March 5, 2025 - Initial Alpha Release
e First alpha release on CTR2 user group
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